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Sample Mathematics Unit Plan

This three-day lesson plan introduces students to metric measurement and conversions of units
within the metric system. The plan centers primarily on linear measure. It is intended for grades
5 and/or 6, although the methods of unit conversion are appropriate for higher grades in which
measurements of capacity and mass are typically covered. This lesson plan is also appropriate
for middle-grade science classes, since measurement in the sciences relies almost exclusively on
metric units.

The lesson plan is partitioned into three or more days during which students engage in the
following activities:

Day 1. Students are guided to create their own paper meter strips, subdivided into decimeters,
centimeters, and millimeters. Students then locate parts of their own bodies that are
approximately equal in length to the subdivisions of the meter. They also consider multiples of
the meter to develop physical interpretations of the decameter, hectometer, and the kilometer.
Their measuring competency is developed as they visit measuring stations located throughout the
classroom to make estimations and compare measurements of a variety of objects.

Day 2. Students begin to apply the relationships between the metric prefixes and learn a variety
of methods for converting from one metric prefix to another. They first examine their own
paper meter strips and the subdivisions of the meter. They discover the mathematical operations
(multiplying and dividing by powers of 10) necessary for making these conversions. Next,
students are guided to see the direct correlation between the metric prefixes and the place-values
of our base-10 numeration system. To help students recall the order of the metric prefixes, a
memory device is introduced (e.g., “King Henry drank milk dunking chocolate munchkins”).
Finally, students are introduced to a hands-on “magic” device called a Metric Genie. They are
shown how this device can be used to easily convert from one prefix to another within the metric
system. (This device was originally developed at the Lawrence Hall of Science, Berkeley
campus of the University of California.) Students are then shown how the Metric Genie
operates and why it works. Specifically, the Genie shifts the decimal places based of multiplying
or dividing by powers of 10. With this knowledge, students are encouraged to create their own
methodologies (similar to the Metric Genie) for converting between metric prefixes.

Day 3. The last day is devoted to applications of the metric system in situations involving the
measurement of length. Specifically, students apply metric measurement in finding distances on
maps that have been scaled in metric units. Finally, students are required to complete a project
requiring them to create a scale model of the solar system using metric units.
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MSTP LESSON TEMPLATE

Teacher(s): Date:
Subject: Grade(s): Time to complete (in periods): 3-5
Mathematics 6 40-minute periods
Unit: Lesson Topic/Title:
Measurement Metric Measurement of Lenoth and Metric Unit Conversions
Student population:

0 Special Educaton OLEP OLD 0O G&T X Academically Average O Low achieving [ Other

OBJECTIVES of the lesson:
[STATE THE SPECIFIC GOALS OF THIS LESSON. WHAT WILL STUDENTS KNOW OR BE ABLE TO DO BY
THE COMPLETION OF THE LESSON?

STUDENTS WILL BE ABLE TO:

« Think in the metric system (SI) by determining personal references in metric units.
Measure length to the nearest centimeter.
Convert from one metric unit of length to another unit within the metric system.
Estimate metric lengths.
Apply metric measurement in problem-solving situations.

o L] L] °

BACKGROUND KNOWLEDGE necessaty for students before engaging in this lesson:

STUDENTS MAY NEED TO REVIEW THE FOLLOWING BACKGROUND KNOWLEDGE:
« How to use a ruler with Standard American units.
« Knowledge of decimal place values.
« Knowledge that multiplying numbers by powers of 10 moves the decimal point to the right; dividing
numbers by powers of 10 moves the decimal point to the left.
« How to find the perimeter and area of plane figures.
« How to read a map and scaled distances.

PRECONCEPTIONS that may need to be addressed:

STUDENTS MAY HAVE THE FOLLOWING MISCONCEPTIONS:
« Since customary rulers have 16 subdivisions, fractions should be used in all measurements rather than
decimals.
« Metric measurements are rarely used. Most people use Standard American measurements, except in the
sciences and in sports.

List 1 or 2 of the overarching NEW YORK Write out CODES and PERFORMANCE
STATE MATHEMATICS STANDARDS to | INDICATORS for RELATED MATHEMATICAL
be addressed in this lesson: CONTENT & PROCESSES addressed in this
lesson:
6.CN.1 Understand and make connections and conjectures
MEASUREMENT STRAND in their everyday experiences to mathematical
Students will: ideas.
« determine what can be measured and how, |6.CN.9 Recognize and apply mathematics to other
using appropriate methods and formulas; disciplines and areas of interest.
« Uuse units to give meaning to measurements;
o understand that all measurement contains 6.CN.2 Explore and explain the relationship between
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MSTP LESSON TEMPIATE

error and be able to determine its
significance;

+ develop strategies for estimating
measurements.

NUMBER SENSE AND.OPERATIONS STRAND
Students will:

+ understand numbers, multiple ways of
representing numbers, relationship among
numbers, and number systems;

+ understand meanings of operations and
procedures, and how they relate to one
another;

« compute accurately and make reasonable
estimates.

mathematical ideas.

6.CN.3 Connect and apply mathematical information to
solve problems.

6.CN.4 Understand multiple representations and how they
are related.

6.CM.3 Organize and accurately label work.

6.CM.4 Share organized mathematical ideas through the
manipulation of objects, numerical tables,
drawings, pictures, charts, graphs, tables,
diagrams, models, and symbols in written and
verbal form.

6.CM.11 Decode and comprehend mathematical visuals
and symbols to construct meaning.

6.R.5 Use representations to explore problem
situations.

6.R.7  Use mathematics to show and understand
physical phenomena (e.g., determine the
perimeter of a bulletin board).

5.M.3  Measure to the nearest centimeter.

5.M.4  Identify equivalent metric units of length.

5.M.5  Convert measurement within a given system.

5M.6  Determine the tool and technique to measure
with an appropriate level of precision: lengths.

5.M.10 Determine personal references for metric units.

5.M.11 Justify the reasonableness of estimates.

5.N.8  Ordering decimal numerals.

6.N.15 Ordering rational numerals.

6.N.21 Multiple representations of rational numerals.

MAJOR CONCEPTS addressed:

o Thinking in the metric system (SI), as well
as in the customary (Standard American)
measurement system.

» Understanding relationships among the
metric prefixes.

o Measuring length.

MAJOR SKILLS addressed:

« Competence in converting between prefixes within
the metric system.

« Competence in estimating metric units of length.

« Competence in metric measurement of length.

« Competence in applying metric measurement in real-
world situations.

« Competence in interpreting scaled distances on
timelines and maps.

APPLICATIONS to Science and/or Technology: [Include 1 or 2]

Scientists use the metric system (SI) for measuring lengths, mass, capacity, and temperature. The metric system is
used in technology because it offers more precision in measurements than the Standard American system.
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MSTP LESSON TEMPLATE

How does this lesson represent BEST PRACTICE?

X Focuses on importaht (standards-based) ideas & [ Builds on prior student knowledge

skills and promotes conceptual understanding (] Aligns curriculum, instruction, and assessment
X Uses a variety of instructional approaches to Establishes cross-disciplinary connections

maintain student engagement (e.g., O lecture, X Establishes real-world connections for students so

0 group work and team work - O demonstration that they generalize lesson concepts to MST

O field trips O role play 0O skits O dramatization). applications

thers) O 0 Please check.

(others) . . . e o 4 [J Prompts higher order thinking (students analyze,
O Encourages guided discovery, inquiry, and design compare and contrast, classify...)
[J' Engages students in peer and self assessment [J Prompts students to generate alternative ideas and
L] Includes key questions to elicit responses that reflect strategies

understanding of important content [J Adjusts instructional methods according to student
X Promotes procedural fluency population and understanding
[J' Addresses naive conceptions [J Procedure includes summary focused on key ideas
[ Prompts discourse among students and with teacher [J Motivates learning during and beyond the lesson

MATERIALS AND RESOURCES Needed (List IT resources and other materials)

Rulers (metric and customary), the attached plain paper strips, paper meter sticks, “metric genies,” and daily
activity sheets.

INSTRUCTTIONAL PLANNING: PROVIDE A COMPLETE SEQUENCE OF ALL
TEACHING PROCESSESS AND STUDENT ACTIVITIES INVOLVED IN
IMPLEMENTING THE LESSON.

This should include ALL teacher explanations, examples, questions, and student activities
associated with the delivery of the lesson. Nothing should be left to the imagination. Other
teachers should be able to reproduce this exact lesson using this lesson plan. Indicate (with an
asterisk) where embedded formative assessments will occur during the implementation of the
lesson. Indicate instructional alternatives that may be employed for differentiating instruction for
students with special needs.

Day 1. The lesson focuses on the metet, the basic unit of length in the metric system. Students will
create a meter strip, obtain approximations for these lengths on their own body, in the classroom, and
on the playground.

Do now: This initial activity will review the process of multiplying and dividing decimal numerals by
powers of 10. For example, 0.45x10=4.5, 2.3 x 100 = 230., 74.6 x 1000 = 74600, and .8+ 10
=.08,6.1 =100 =.061, 92+ 1000 =.092 . The teacher will ask: What happens to the decimal point
when we multiply by 107 ... by 100? ... and by 1000? (Ans. The decimal shifts to the right 1 place,
...2 places, ...and 3 places.) What happens to the decimal place when we divide by 107 ...by 1007 ...
and by 1000? (Ans. The decimal shifts to the left 1 place, ... 2 places, ... and 3 places.) The teacher
will state, “These ideas will be used in the lesson for today. I'm glad you remembered about
multiplying and dividing by powers of ten.”
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MSTP LESSON TEMPLATE

Motivation: What is a metet? Let’s build a meter strip and find out!

.

First, students will be given an introduction to the metric system:

A system of measurement called the Metric System is used in most countries around the
world. It is also called the International System of Units (abbreviated SI from the French
language). This system is based on the decimal (or base 10) numeration system. The
place values of the decimal numeration system correspond directly with the subdivisions
of the units within the metric system. The metric system has special names for units of
length, weight or mass, capacity, and temperature. Scientists like to use the metric
system because they frequently work with very large or very small numbers and need a
lot of precision in their measurements.

First, we will focus on the basic unit for length, known as the meter. We will examine 7
subdivisions of the meter — 3 larger and 3 smaller than the meter. These subdivisions
have special names, similar to our place value names.

Students will be guided to create their own meter strip and all of its subdivisions.

The teacher will distribute one paper meter strip, marked off in centimeter units, to each
student. (These are provided in the attachment, Day 1: Two Meter Strips.) For the exact
instructional sequence, see the attachment entitled Day 1: Activity Sheet 1 and Class Notes.
In brief, students will be told the names of these subdivisions in terms of their fractional part of
a meter. Students will also create measurement strips that are multiples of 10 meters each; e.g.,
10 meters, 100 meters, etc. They will name these lengths in terms of metric units. *Students
will locate parts of their body that are equivalent in length to various metric units, thus
providing personal references to metric units.

Students will work in pairs and visit several stations as they complete the attached activity sheet
entitled Day 1: Activity Sheet 2. *This activity will be used to assess students’ measuring
competency. After students have measured themselves as requested on Activity Sheet 2,
students will report their work on Activity Sheet 2 to the whole class and answer questions from
their peers and the teacher.

*Homework: It is highly probable that students will not be able to complete Activity Sheet 2

before class is over. Completion of the remainder of the sheet will be required for homework.

Day 2. This lesson focuses on conversions between units (of length) within the metric system.

Students will be asked to use the knowledge they have gained through constructing their own meter
strips to make metric conversions by multiplying or dividing by 10, 100, or 1000. *They will do
these conversions using paper/pencil or calculator computations.

Do Now. Convert each of the following to the indicated metric unit:

3m= cm, 80 cm= dm, 2.5dm= mm, 709 hm = km

It is anticipated that many students will find this laborious, difficult, and time consuming.
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MSTP LESSON TEMPLATE

Students may need to be reminded to look at their meter strip to discover the relationship
between the prefixes.

Motivation: After about 5 minutes, the teacher will ask the class if they would like to learn
about a device that will make metric conversions very easy, if fact, almost magic!

«  Students will be introduced to a hands-on device called the Metric Genie (created by the
Lawrence Hall of Science). The teacher will distribute a Metric Genie to each student (See
attachment, Day 2: Metric Genies for 5 Students). The Metric Genie is a device that
helps students easily locate the decimal point in order to convert between metric units.
(Note: The logic underlying this procedure should not be lost. It is important that students
realize that the Metric Genie simply multiplies or divides the given metric unit by powers of
10 when shifting the decimal point either to the right or to the left, respectively.)

« Students should be provided a quick review of the base ten place-value system and its
relationship to metric prefixes as shown below.

1000 100 10 1 1 .01 .({Ol

Kilometer = IOﬂO meters
Hectometer = 100 meters
Decameter = 10 meter
Meter = 1 basic utjit of len
Decimeter = .1 meters
Centimeter = .01 meters V
- Millimeter = .001 meters

The bold letters show the abbreviations for the metric units.

km  hm dam M  dm cm mm
It is important that students remember the order of these prefixes and units. Thete is a
little saying (mnemonic) that may help students remember.

“King Henry drank milk dunking  chocolate munchkins.”

Students should be encouraged to create your own sentence for remembering the
metric prefixes or units.

« Using the Metric Genie
Consider the following conversion: 45cm=2? m
Remind students that if no decimal is shown in a number, it is assumed to be to the
right of one’s place. Therefore, 45 =45e

As shown on the Metric Genie below, we first place the Genie on a clean sheet of
paper and enter the given number into the Genie in the open circles and rectangles so
that the decimal point is placed in the circle with the original prefix and the
numerals fit into the open rectangles, relative to the location of the decimal.
Next, we find the desired conversion unit (m) and move our decimal point to that
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MSTP LESSON TEMPLATE

new location. Therefore, 450 decimeters is converted to @45 meters. This whole
process is indicated below.

Shown on the Genie:

Kilo- Hecto- Deca- MLG Deci- Centi-
Look at the original entry: 4 5
km hm dam M dm cme mm

Look at the converted entry:

km hm dam M / c mm

Therefore, 45 cm = .45m .

It’s like Magic!!!

Of course, this whole process of moving the decimal two places to the left is the same as
dividing a number by 100. In this problem, we know that there are 100 centimeters in 1
meter. Therefore, 45 cm is only .45 m. Several other examples of using the Genie should
be illustrated at this point. The Genie (template) should be placed on a clean section of the
paper prior to beginning each new problem.

« *Students will use their Metric Genies to gain procedural fluency in converting between units
within the metric system. A class activity is provided on attachment, Day 2: Class Activity
Sheet, Metric Genie. The teacher will circulate the classroom, assisting students as necessary
and checking on students’ progress.

« Assoon as students gain proficiency in metric conversions using the Metric Genie, they must
create their own memory device for metric conversions. Students should eventually be
“weaned from the Genie” (in approximately one week). Students with special needs will be
allowed to use the Metric Genie as long as necessary.

*Homework: See attachment, Day 2, Homework.

Day 3. This lesson focuses on applications of metric measurement in situations involving the
measurement of length. These include map reading (scaled in metric units) and desi gning scale
models of the solar system.

Motivation: How do we use the metric system in real-world measurement activities?
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MSTP LESSON TEMPLATE

Students will be divided into groups of 2 or 3 (with varying abilities) to do measurement activities
included on the attachment entitled: Day 3: Activity Sheet , Measuring with a Metric Ruler.

*For Part I on the Day 3 Activity Sheet, students will need to be reminded (or taught) how to round
off numbers and how to measure “to the nearest centimeter.” Specifically, if a measurement
extends into part of a centimeter, it will be included in the final measurement of the item only if the
part is .5 cm or larger.

For example, the following measurements have been rounded-off “to the nearest
centimeter’:
13.6 cm, it will be recorded as 14 cm
12.3 cm, it will be recorded as 12 cm
10.5 cm, it will be recorded as 11 cm
*The teacher will circulate the room, observing students’ progress and assisting as needed.

*For Part II on the Day 3 Activity Sheet, students will need to measure distances between cities on
the map to the nearest centimeter. Then, in order to convert the scaled distances to their actual
distances, students will need to apply the map scale (1 cm = 200 km). This means that each
centimeter will be multiplied by 200 km.

For example, the map distances should be converted to their actual distances as follows:

Scaled Distance Real Distance
3cm => 3 %200 => 600 km
7cm => 7*%200 => 1400 km

*Homework: See attachment, Day 3: Project Homework, Build a Scale Model of the Solar
System

Follow-up activities will introduce students to the metric units of capacity (liters) and mass (grams).

For ready-made quizzes go to:
www.edhelper.com/measurement.html

For practice on the decimal system and metrics, go to:

www.ncwdn.org/decimals/metric.html

For additional lessons go to:

www.nist.gov/public affairs/kids/ metric.html

www.teach-nology.com/teachers/lesson plans/math/
www.mathforum.org/paths/measurement/e.measlessons.html

ASSESSMENT Methodologies [Embedded Diagnostic, Formative and Summative] planned to
demonstrate the degree to which students have mastered the listed NYS Petformance Indicators
indicated on the prior page. ¥*Attach COMPLETE EXAMPLES of all methods checked below*
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MSTP LESSON TEMPILATE
X' Selected Response: (Circle type(s): Paper/pencil tests; multiple choice; true/false; matching; shott answer
fill-ins)
Essay: (Citcle type(s): Extended written answers; Graphic otganizers - KWL or TWK) (indicate guiding
questions, scoring criteria, and sample student responses)
Constructed Response: (Circle type(s): Multi-steps; Document-based questions) (indicate guiding questions,

scoring criteria, and sample student responses)
Performance Assessment: (Circle type(s): Individual; group; product-based; performance-based; artistic;

authentic. (Indicate guiding questions, scoring criteria, and sample student responses.)

Classtoom observation (Citcle type: Formal; Informal) (5f formal, indicate guiding questions, scoring criteria, and
sample student responses)

Whole class discussion (indicate guiding questions, scoring criteria, and sample student responses)

Small group discussions (indicate guiding question, scoring criteria, and sample student responses)

Individual student interviews (zndicate interview questions, scoring criteria and student responses)

Process or Reflective measures: (Circle type: Journals; Logs) (indicate scoring method; explain development and

use of rubrics; provide an excample of a finished journal)

Portfolios (indicate scoring method; explain development and use of rubrics; provide an example of a finished portfolio)
In-class worksheet/written assignment (explain assignment and/ or provide example of student work)
Quiz/Test/Exam (indicate scoring method; provide an example)

Others (describe): Create a scale Model of the Solar System; Project [Choose one from: Design the
largest playground (greatest area) with a given perimeter of 12 decameters or Using the metric system,
make a scale model of the middle school (outside measutes only)]. See Project Scoring Rubric.

<o O O

“HXO OO0

DESCRIPTION OF SUMMATIVE ASSESSMENT: Indicate how students’ learning of lesson
objectives (stated earlier) was comprehensively assessed. (“Post” assessment.) Include description
of assignment and sample items. Attach scoring criteria (checklist or rubrics) used to evaluate the
work, and three samples of student wotk (high, medium, and low).

See Summative Assessment (Attached). Part I is an in-class test which will be graded for accuracy
and completeness.

Part Il is a group project. It will be assessed by collecting and grading student work (See attached
Rubric for Project Evaluation). The teacher will observe student interaction and evaluate informally the

process that students apply in solving the problem.

AFTER LESSON IMPLEMENTATION, PROVIDE YOUR REFLECTIONS: Tell the story of
what happened in the classroom. Indicate what worked, what you would change for the next
implementation, and students’ reactions to the lesson. Use additional pages if needed.

[To be completed after these lessons have been implemented.]

This next page can be used to create meter strips for each student. Each rectangular unit is 1 centimeter
wide. Students can cut out strips and tape them together to form one long strip that has a length of 100 cm
(or 1 meter). The next page is large enough to create two meter strips.
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MSTP LESSON TEMPLATE

Day 1
Activity Sheet 1 and Class Notes

Distribute one meter strip (from the given template above) to each
student in the class and complete the following activities.

Students should fill in the blanks as they create the metric units.

1. The distance from my to my
is about 1 meter long. A meter is the standard unit in the metric system
for measuring length. Its abbreviation is m. Sometimes it is written as
“metre” instead of “meter.”

2. Fold your meter strip into 10 equal pieces. One of these units is called a

decimeter. Fill in the blanks: decimeters = 1 meter;
1 decimeter = meter (This answer will be a fraction).
The width of my is about 1 decimeter.

The abbreviation for decimeter is dm. The prefix deci- means one-tenth,
which can be written as 1/10 or 0.1

3. Each pre-marked unit on the meter strip is called a centimeter. Count the
number of centimeters on the meter strip. Fill in the blanks:

centimeters = 1 meter; 1 centimeter = meter;
centimeters = 1 decimeter.
The width of my is about 1 centimeter.

The abbreviation for centimeter is cm. The prefix centi- means one-
hundredth, which can be written as 1/100 or 0.01. |

4. Use a very sharp pencil point to divide one centimeter into 10 equal parts.
One of these tiny units is called a millimeter. If you marked off the whole
meter into millimeters, how many millimeters would be in the whole

meter? Fill in the blanks: millimeters = 1 meter;
I millimeter = meter; millimeters = 1 centimeter.
The width of my is about 1 millimeter.
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MSTP LESSON TEMPLATE
The abbreviation for millimeter is mm. The prefix milli- means one-
thousandth, which can be written as 1/1000 or 0.001.

We need 10 student volunteers to come to the front of the room with
their meter strips. We will tape these 10 meter strips end-to-end to
form one long strip. This long strip is called a decameter. Fill in the
blanks: 1 decameter = meters. The abbreviation for
decameter is dam. The prefix deca- means 10. The length of a
decameter is about

Imagine this: Suppose you taped 10 decameters together to make one
really long measuring strip. This big strip is called a hectometer. 1
hectometer = meters. The abbreviation for hectometer is

hm. The prefix hecto- means 100.

Finally, imagine this: Tape 10 hectometers together. How many meters
would you use? This super long unit is called a
kilometer. 1 kilometer = meters. The abbreviation for
kilometer is km. The prefix kilo- means 1000. One kilometer is a little
more than 2 mile (0.6 miles) or the length of 10 football fields!
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MSTP LESSON TEMPLATE

Class Activity Sheet 2

Determining Personal References for units of length in the Metric System (SI)
Materials: blank paper strips, centimeter ruler, meter stick .

The teacher will demonstrate how to use the blank paper strip for measuring. A pencil and
the paper strip will be used to mark off the length of the item. Then, the distance of the mark
on the paper strip from the (initial) end of the strip will be measured using a centimeter ruler
or meter stick.

1. Station 1: Use a meter stick to measure the door: base and height. Determine its
perimeter in centimeters and then in decimeters.

2. Station 2: Identify the appropriate metric unit to estimate the measure of the following:

a. Thickness of a dime

b. Thickness of a crayon

c. length of your teacher’s desk

d. Distance from Chicago, IL to Manhattan, NY

3. Use your paper strips to find the following measurements requested in the table below:
(Complete for homework if you cannot finish in class.)
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MSTP LESSON TEMPLATE

MEASUREMENT LENGTH OR CIRCUMFERENCE
Around the base of my thumb cm
Around my wrist cm
Around my neck cm
Around my waist cm
Around my head cm
Arm span dm
Elbow to wrist dm

4. There is an old saying that one time around your waist is equal to two times around your neck.

Is this true for you? Why or why not?

5. There is another old saying that one time around your neck is equal to two times around your

wrist. Is this true for you? Why or why not?

6. There is an ancient belief that a person's height is equal to the distance from the person’s
longest fingertip on the left hand to the corresponding fingertip on the right hand. Determine
your height and arm span measurements at one of the stations your teacher has set up. Is this
true for you? Why or why not?
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MSTP LESSON TEMPLATE

Day 2

Metric Genies for Five Students

Cut out the rectangular and circular regions above each prefix. Place the Genie on a clean section
of paper. Enter the decimal point of the given unit in the circle above the given prefix (or unit).
Enter the numerals in the rectangular spaces, respective to the given decimal point. Place an x over
the original decimal point and then insert a new decimal point in the circle above the prefix to
which you are making the conversion. Metric Genies are included below (idea borrowed from the

Lawrence Hall of Science, University of California, Berkeley).

Kilo- Hecto- Deca- ML, G

Deci-

O

Centi-

O

Milli-

Kilo- Hecto- Deca- M, L, G

Deci-

Centi-

Kilo- Hecto- Deca- ML,G

Deci-

O

Centi-

Kilo- Hecto- Deca- M, L, G

Deci-

Centi-

Kilo- Hecto- Deca- Mﬁ L,G

Deci-

Centi-
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MSTP LESSON TEMPLATE
Class Activity Sheet

Metric Genie

uououououuu

Kilo- Hecto- Deca- Meter Deci- Centi- Milli-

Liter
Gram

Use the Metric Genie to convert to the metric unit indicated:

1. 34 m = cm 2. 45m= hm

3. 72km= mm 4, 0.36dm = ni

5. 835 dam = mm 6. 9.035dm = dam

7. 62.4cm = dm 8. 90.5 km = m
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MSTP LESSON TEMPLATE

Day 2 Homework
Convert to the indicated unit, using the Metric Genie.
Part [

l. Scm = hm

2. 23 mm= km

3. 6m = dam

4. 67 dam = km

To convert to a smaller unit, you should move the decimal point to the right, like the
following example: 6 hm = ? dm

Metric Genie:

LJ I_ly, o] Uo_%

Hecto- Deca- M, L, G Deci- Centi- Milli-

Look at the original entry:

6
km hme dam M dm cm mm
Converted entry: 73 73
6 0 ; 0
km hm dam M dm e cm mm

Notice that the empty boxes between the original number and the decimal point are filled-in
with zeros.

Therefore, 6 hm = 6000 dm
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MSTP LESSON TEMPLATE

Part II Determine the following conversions.

1. 8hm= __ mm

2. Sdam = | cm

3. 1.7m= __ dm

4, 1.23km=__ m

Part III

l. 56 km = mm

2. 1.2 cm = dam

3. 346 mm = dm

4, 168 m = hm

5. 0.75 dm = cm

6. 9hm = m

7. 100mm = dm

8. 2000cm = dam

9. 7654m = mm

10. 4dm = km

Part IV

Compare using >, <, or =. [Hint: Convert the measurements to the same unit.]
1. 56cm O 6m 2. 7dam O 6980 mm
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MSTP LESSON TEMPLATE

Day 3
Activity Sheet
Measuring with a Metric Ruler
Part 1

Measure each line segment to the nearest 0.1 centimeter:

1.

2.

6. Which line segments are the closest in length?

7. Which line segments are the furthest apart in length?

8. Can you measure the lengths of these paper clips? How much longer is the
larger paper clip than the smaller paper clip?

c e
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MSTP LESSON TEMPLATE
Part I1

Map Skills: Measuring to the nearest whole centimeter.

Below is a map of the early 1800’s. Use your metric ruler to
measure the following distances to the nearest whole
centimeter. Then, use the scale below to estimate the real
distance in kilometers between the cities.

Scale: 1 cm =200 km.
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Map Distance Real Distance
Santa Fe to Independence cm km
San Antonio- to New Orleans cm km
Albany to New York cm km
Tucson to El Paso cm km
Chicago to Sacramento cm km
Portland to San Francisco cm km
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Project--Homework

Build a Scale Model of the Solar System

Imagine that you could travel far into space and look back at the Solar System. You would see the planets moving in
their orbits, at different distances from the Sun. All of the planets move in the same direction, revolving
counterclockwise around the Sun. Are some planets too small to be seen from space? A scale model may help you
to visualize the relative size of the planets.

The Size of the Physical Bodies in the Solar System

For this project, consider the radius of each of the physical bodies in the solar system listed in the table below.

THE SOLAR SYSTEM

Name Radius (km) | Rounded to 1000s | S°3ed fcm =
Sun 695000
Mercury 2439.7
Venus 6051.8
Earth 6378.14
Mars 3397.2
dupiter 71492
Saturn 60268
Uranus 25559
Neptune 24746
Pluto 1137

Instructions:

o In the third column of the table, round-off each of these values to the nearest thousand.

« In the forth column of the table, record the scaled size of each radius using the scale 1 cm =1000 km.
For example, if the radius is 5,000 km , then the scaled size would be 5 cm.

. Create a scale model of each of these physical bodies in the solar system using the procedures below.
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> Draw and cutout a circle with the scaled radius for each of these physical bodies in the solar
system. On each circle, write the name of the physical body it represents. Also, draw its radius
and record its actual value on the radius.
> Color each of these circles with the color of the actual physical body it represents. (Pictures of
these bodies can be found on the following web page: http://www.solarviews.com/ )

http://www.solarviews.com/

Views of the Solar Sy

www.aolarviews.com

+ Connect these circles together with string in their actual order from the sun.
+ Describe at least two unique characteristics of the object.
+ Putyour name on the project and turn it in to your teacher three days after the assignment was given.
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Summative Assessment

Part I This section is an in-class test. You have the full period to complete it. Each problem is
worth 3 points.

A. Write the correct abbreviation for each metric unit.

1. Kilometer 2. Millimeter 3. Decimeter
4. Hectometer 5. Decameter 6. Centimeter
7. Meter

B. Describe a physical approximation for each of the following metric units of length.

1. Kilometer

2. Millimeter

3. Decimeter

4. Hectometer

5. Decameter

6. Centimeter

7. Meter

C. Complete these conversions. You may use your Metric Genie.

1. 12000 mm = m 2. 5cm= mm 3. 104km= hm
4. 1.6 cm= dm 5. 19.8 m= km 6. 250 dam= dm
7. 5.6 hm= m 8. .63dm= mm 9. 145cm= m

D. Compare using >, <,=

1. 536em O 536dm 2. 492mm O 5m  3.36m O 360em

4. 5dm O 508 mm
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E. Fill in the blanks:
1. Multiplying a decimal number by 100 shifts the decimal places to the
2. Dividing a decimal number by 1000 shifts the decimal places to the

3. Multiplying a decimal number by 10 shifts the decimal places to the

F. The following sentence that helps me remember the order of the metric prefixes is:

G. Explain two reasons for using the metric system in measurements.

H. On a map, if two cities are 4.5 cm apart and the map scale is 1 cm = 200 km, how far are
the cities actually apart? Explain.

Part II This part is a project that must be completed with a partner. See the grading rubric
below. It is due in three days.

Choose one problem:

1. Design the largest playground (greatest area) with a given perimeter of 12 decameters.
You may choose any shape you wish for the playground. Please provide a written
description of the procedures you used.

2. Using the metric system, make a scale model drawing of the middle school (outside
measurement only). Please provide a written description of the procedures you used and
indicate the scale used for interpreting the scale model.

172



MSTP MATH Lesson Template

Rubric for Assessment of Projects

(1 point = 8.4%)

Dimension Excellent Good Fair Needs Work
4 points 3 points 2 points 1 point
Conceptual ¢ Excellent use of Good use of Demonstrates Demonstrates only a
Understanding of mathematical mathematical partial under- limited understanding
Mathematics concepts/language. language and standing qf of concepts and/or
Involved e An array of words, concepts but mathematical procedures.
tables, and contains some concepts and key May address some
illustrations may be N0 errors. terminology. elements of the task
used. Good conceptual May show some correctly but reaches
e Demonstrates a understanding of misunderstanding an inadequate
thorough key concepts of underlying solution and/or
understanding of the shown in multiple mathematical provides reasoning
mathematical ways. concepts. Fhat 1s faulty or
concepts and/or All components Includes many incomplete.
procedures embodied are included and components which Reflects a lack of
in the task. meet expectations. meet expectations, understanding of the
but not all. underlying math
concepts.

Solutions to

o Contains clear,

Good evidence of

Addresses most

Solutions reflect

Problems complete strategies used. aspects using multiple flaws related
explanations Procedures for mathematically to a misunderstanding
e Use mathematically solving problems sm;nd progedures on how to solve.
sound are mathematically and strategies. Uses inappropriate
procedures/ strategies sound. May contain procedures/strategies.
é I—?é‘L WORK May contain an glcortetijt solutions Work is unclear and
! incorrect solution ut app vets an difficult to follow.
. approptiate i
o Al pro&alems solved but tﬁpphzs all strategy using valid May contain a cotrect
correc mathematica ’ :
Y appropriate Y reasoning and an solution but no work
. . i shown.
process with valid explanation.
reasoning in the May contain
explanation. correct solutions
All components accomp anied by
included and meet mcomdp lete
expectations. procecure,
reasoning, and/or
explanations.
Includes many
components which
meet expectations,
but not all.
Written Work e Excellent overall Good overall Most components Pootly written and
and Visual structure and structure & neat. written adequately. diagrams are flawed
Presentation diagrams. Clearly organized Diagrams are or not included.

e Work connects an
array of concepts.

¢ All components
include and work
goes beyond what is
expected.

e All explanations are
cleatly presented.

e Work is extremely
neat.

work which
connects multiple
concepts.

Most explanations
are cleatly
presented with few
areas of confusion.
e All components
includes and meet
all expectations.

4719

somewhat
ambiguous.

Wortk is not very
neatly presented.

Content contains
major errors and
misunderstanding of
terms.

Few components are
included with meet
expectations.

Not neatly presented.
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Keep for future reference

Overview of the Metric (SI) System
National Institute of Standards and Technology

http://www.nist.qov/metric

You Will Need to Know About Metric
(For Your Everyday Life)

Metric is based on the Decimal system

The metric system is simple to learn. For use in your everyday life you will need to

1 O know only ten units. You will also need to get used to a few new temperatures. Of
course, there are other units which most persons will not need to learn. There are
even some metric units with which you are already familiar; those for time and
electricity are the same as you use now.

BASIC UNITS

Meter: .
a little longer than a yard (about 1.1

yards)

Liter: .
a little larger than a quart (about 1.06

quarts)

Gram: . .
a little more than the weight of the

paper clip

N 2}%‘%@?‘ COMMON PREFIXES

et W (to be used with basic
units)

p milli: one-thousandth
=Y (0.001)
'Y centi:one-hundredth

S (0.01)

w2 o) | kilo: one-thousand times
& | (1000)

1LITER 1 QUART

25 Degrees Fahrenheit ~ For example:

1000 millimeters = 1 meter
100 centimeters = 1 meter
1000 meters = 1 kilometer
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OTHER COMMONLY USED UNITS
millimeter: 0.001 meter - diameter
{ of a paper clip wire
centimeter: 0.01 meter - a little
more than the width of a paper clip
~1 (about 0.4 inch) !
.| kilometer: 1000 meters - somewhat
further than 1/2 mile (about 0.6
miles)
kilogram: 1000 grams - a little more
- than 2 pounds (about 2.2 pounds)
25 Degrees Celsius milliliter: 0.001 liter - five of them
make a teaspoon

OTHER USEFUL UNITS 1 Kilogram
hectare: about 2 1/2 acres
metric ton: about one ton
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Sample Science Unit Plan

This two- to three-day lesson plan introduces eighth grade science students to methods for
estimating populations in an ecosystem. Scientific concepts are elucidated by applications of
ratios and proportions. This lesson is intended for implementation in a science laboratory
setting.

The lesson is partitioned into two extended science laboratory periods, during which students
engage in the following activities:

Day 1. Students are introduced to three methods for estimating the size of a population of a
given species, namely, the observation, sampling, and mark-and-recapture methods. Each
method is considered within a specific context and the merits of each are discussed. Examples of
each method are illustrated and computational procedures using ratios, proportions, and percents
are explored. Students are given reinforcing class activities and homework associated with these
three methods of estimating populations.

Day 2. The method of mark-and-recapture is refined on the second day. Students learn that it
is better to have more than one sample of a population for estimation purposes. In particular,
more samples of a population will produce more reliable estimates of the true population size.
For this purpose, the mark-and-recapture (with repetitions) method is illustrated. Students then
engage in laboratory activities that exemplify this methodology. They are required to write a
complete lab report of their findings based on established guidelines.
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Teacher(s): Date:

Subject: Science/Living Grade(s): 8 Time to complete (in periods): Two extended
Environment science laboratory periods

Unit: Ecology . Lesson Topic/Title: Estimating Populations

Student population:
O Special Education OLEP O LD O G&T X Academically Average O Low achieving [ Other

OBJECTIVES of the lesson:
[State the SPECIFIC Science and Mathematics goals of this lesson. What will students know or be able to do by the
completion of the lesson? |

Students will be able to:
1. Estimate population size by acquiring a sample from a sub-region of an ecosystem.
2. Use the mark-and-recapture method to estimate the size of a population.
3. Describe factors that may affect population size.

BACKGROUND KNOWLEDGE necessaty for students before engaging in this lesson:

Students should understand that a population consists of all of the members of one species living in one area
(ecosystem) and that there are many biotic and abiotic factors that affect the size of a given population.

PRECONCEPTIONS that may need to be addressed:

Students may believe that the only way to determine a population’s size is to capture and count each individual
organism.

List 1 or 2 of the overarching NEW YORK | Wtite out CODES and PERFORMANCE INDICATORS
STATE SCIENCE STANDARDS to be for RELATED SCIENTIFIC CONTENT &
addressed in this lesson: PROCESSES addressed in this lesson:

6.1: Explain factors that limit growth of individuals and
Key idea 6: Plants and animals depend on each |populations.

other and their physical environment.
6.1de: The number of organisms any habitat can support is
limited by the available energy, water, oxygen, & minerals
and by the ability of ecosystems to recycle the residue of dead
organisms through the activities of bacteria and fungi.

6.1f: Living organisms have the capacity to produce
populations of unlimited size, but environments and resources
are finite. This has profound effects on the interactions among
organisms.
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List1 or 2 of the overarching NEW YORK |Write out CODES and PERFORMANCE INDICATORS
STATE MATHEMATICS STANDARDS to |for RELATED MATHEMATICAL CONTENT &
be addressed in this lesson: PROCESSES addressed in this lesson:

Connections: Apply math to science

= [8.CN.9 Recognize and apply mathematics to other disciplines, areas of
interest, etc.

Algebra: Ratio & proportion, formulas =% 8.PS.10 Use proportionality to model problems.

Statistics & Prob.: Predictions from Data =»  |7.S.8 Interpret data to provide the basis for predictions.

MAJOR CONCEPTS addressed: MAJOR SKILLS addressed:

Science: Population studies Science:

Analyzes results from observations/expressed data.

Mathematics: Ratio & proportion; connections | Mathematics:

Setting up and solving proportions.

How does understanding the listed math concepts INFORM Science knowledge? (Not just math that is
simply related to the science, but math that helps students bettet understand the science ideas)

By setting up a proportion and using algebra to calculate an estimate of the size of a species, students will
observe relationships between the following: (1) the ratio of the number of animals in a species that has been

marked, compared to the entire population and (2)

the ratio of the number of recaptured animals in a species

having marks, compared to the total number recaptured animals. Such a proportional relationship is

frequently used by scientists to estimate the size of a population when it is not possible or practical to actually

count each member of a given population.

How does this lesson represent BEST PRACTICE?

v Focuses on important (standards-based) ideas &
skills and promotes conceptual undetstanding

v'Uses a variety of instructional approaches to
maintain student engagement (e.g., O lecture
X group work and team work O demonstration

O field trips O role play O skits O dramatization).

X (others) modeling O Please check.
[0 Encourages guided discovery, inquiry, and
design

O Engages students in peer and self assessment

Includes key questions to elicit responses that
reflect understanding of important content

v Promotes procedural fluency
[J Addresses naive conceptions

v Prompts discourse among students and with
teacher

v’ Builds on prior student knowledge
v Aligns curriculum, instruction, and assessment
v’ Establishes cross-disciplinary connections

[ Establishes real-world connections for students so that
they generalize lesson concepts to MST applications

Prompts higher order thinking (students analyze,
compare and contrast, classify...)

Ul

[J Prompts students to generate alternative ideas and
strategies

O Adjusts instructional methods according to student
population and understanding

O] Procedute includes summary focused on key ideas

v Motivates learning during and beyond the lesson
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MATERIALS AND RESOURCES needed (including IT resources and other materials)

Estimating population size pre- and post-assessment

Counting turtles lab packet

Hand-held calculators

Model turtle populations (a package with an unknown number of “turtles”; one per 2 students)
Investigating populations report guidelines

Assortment of turtle reference books

Model of a report on an overhead transparency

List of turtle reference websites

Scoring rubric for lab reports

Environmental Science textbook for general populations estimating information

INSTRUCTIONAL PLANNING: PROVIDE A COMPLETE SEQUENCE OF ALL TEACHING
PROCESSESS AND STUDENT ACTIVITIES INVOLVED IN IMPLEMENTING THE LESSON.
This should include ALL teacher explanations, examples, questions, and student activities associated with
the delivery of the lesson. Nothing should be left to the imagination. Other teachers should be able to
reproduce this exact lesson using this lesson plan. Indicate (with an asterisk) where embedded formative
assessments will occur during the implementation of the lesson. Indicate instructional alternatives that
may be employed for differentiating instruction for students with special needs. *BE SPECIFIC ABOUT
HOW MATHEMATICAL CONCEPTS ARE INFUSED INTO THIS SCIENCE LESSON* Use
additional pages if needed. See below.

Day 1
1. Administer pre-assessment.
2. Facilitate a class discussion of estimating populations. “If scientists wanted to determine the size of a
population, like crickets in a field or cliff swallows in a cliff colony, what techniques could they use?”
e Observation

— Direct: count them

— What difficulties may arise when using this method?

Anticipated answers: The population may be too large to count. The population may be
spread out over too large a region of access. The conditions may not allow counting of
the whole population.

e Sampling

— Take a sample from a sub-region of the ecosystem.

—  For example, to estimate the number of tadpoles in a pond count all of the tadpoles in 1
cubic meter of the pond. Suppose you count 150 tadpoles. Use this information to
estimate the number of tadpoles in the whole pond of 19,000 cubic meters.

Estimated population = 150 * 19,000
= 2,850,000 tadpoles

— Ask: What sources of error may this method impose?

Anticipated answers: The tadpoles may not be evenly distributed in the pond.
A small sample may not be representative of the population.

e Mark-and-Recapture
Suppose that a lake is stocked with catfish and we wish to estimate the total number of catfish in
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the lake. We will take a random sample of 40 catfish from the lake and mark them with tags.
Then we will release these fish back into the lake. The next day we will revisit the same lake and
take a sample of 80 fish from the lake. Suppose that 2 of these fish have tags. Estimate the
“Total population size” of catfish in the lake.

One method to use in this situation is ratio and proportion:

40 = 2 [Ratios of Part to Whole]
Total population 80

2 (Total population) = (40)(80)
Total population = 3200
2
(Estimated) Total population = 1600 catfish

However, we could set up the ratio and proportion another way and still arrive at the save answer:

Total population = 80 [Ratios of Whole to Part]
40 2
2 (Total population) = (40)(80)
Total population = 3200
2

(Estimated) Total population = 1600 catfish

Summary of the Mark-and-Recapture method:

In general, an estimate of the population size using the mark-and-recapture method can be found
by creating and solving a ratio and proportion problem. When two ratios are equal, we say they
are “in proportion.” Thus, we call the equation below “a proportion.”

[Method 1: Proportion]

Number marked = Number marked in subsequent sample [Ratios of Part to Whole]
Total population Number recaptured in subsequent sample

OR

[Method 2: Proportion]

Total population = Number recaptured in subsequent sample [Ratios of Whole to Part]
Number marked Number marked in subsequent sample

e Distribute worksheet for class work. (See attachment). The items not completed in class will be
assigned for homework.
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Day 2

1. Check homework and answer questions regarding the methods for estimating total population size
discussed yesterday.

3. Explain that today we will be discussing ways to improve the accuracy of the mark-and-recapture
method for estimating the total population size of a species.

4. For the technique of mark-and-recapture to be valid, scientists must collect samples randomly from the
entire population. Explain that samples must be chosen to be representative of the whole region and the
whole population. That is what we mean when we say that samples should be “randomly selected.”

For example, if we wanted to use a sample to determine the number of boys in a large room of 100
people, it would not be a random sample if we chose only from the table of 10 people seated near the
front of the room. That would not be a “random sample.” In fact, all girls may be seated at that
particular table. The teacher should facilitate a discussion of ways we might select a more “random
sample” of 10 people from that room.

5. To improve the accuracy of the mark-and-recapture method for estimating the size of a population,
many samples should be taken. In general, the more samples taken, the more accurate the estimate of the
population size. We call this the Mark-and-Recapture Method with Repeated Trials.

For example, suppose the New York Department of Agriculture wants to estimate the total number of
Mallard ducks in Suffolk County during the month of July. To do this, a random sample of 30 Mallard
ducks was taken from various regions of Suffolk county and tagged. The ducks were then returned to
the regions from which they were taken. For each of the next 5 days, 15 Mallard ducks were captured
throughout the county and the number of tagged ducks in the sample was recorded in the chart below.
The ducks were always returned to their habitat after they were captured.

Mark-and-Recapture Method with Repeated Trials
Trial number # captured _ # recaptured having a tag

1 15 2
2 15 1
3 15 2
4 15 3
5 15 0
Totals 75 8

Notice that the total number of ducks captured in the 5 samples was 75 and the total number of
recaptured ducks that had been tagged among the recaptured ducks was 8. An estimate of the total
population size of Mallard ducks may be found by solving the following proportion. (An equivalent
proportion would work as well):

Number marked = Total number marked in subsequent samples [Ratios of Part to Whole]
Total population Total number recaptured in subsequent samples
30 8

TotalPopulation 735
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Total population*8 = 30%75

Total population *8 = 2250
Total population = 2250
Total population = 231.25

(Estimated) Total population = 281 Mallard ducks

6. Distribute lab packets and read the directions with students.
7. Arrange students into pairs.
8. Distribute model turtle populations.
9. Model how to select “turtles” randomly.
10. Invite students to collect data and complete the data table.
11. Remind them to show all work on separate paper, including proportions. Have calculators available for
students.
12. While completing the lab packet, encourage students to take at least five samples before they analyze the
data.
13. Instruct students to answer the lab questions.
14. Distribute the report guidelines and discuss.
15. Provide students with the following resources to complete their reports:
o Turtle resource books from the library.
e Environmental Science text books with population estimation information.
e List of general turtle information websites.

http://en.wikipedia.org/wiki/Turtle

http://42explore.com/turtle.htm
http://www.unc.edu/~dtkirkpa/stuff/maps.html
http://hsus.org/wildlife/a_closer_look at wildlife/turtles_and_tortoises/
http://www.hilozoo.com/animals/AR _p_turtle.htm
http://www.calm.wa.gov.au/science/turtles_general.html

A

¢ Grading rubric for the lab report. [See attachment]

ASSESSMENT Methodologies [Embedded Diagnostic, Formative and Summative] planned to
demonstrate the degree to which students have mastered the listed NYS Performance Indicatots indicated
on the prior page. *Attach COMPLETE EXAMPLES of all methods checked below*
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v Selected Response: (Citcle type(s): Paper/pencil tests; multiple choice; true/ false; matching; short answer fill-
1ns)

[] Essay: (Circle type(s): Extended written answers; Graphic organizers — KWL or TWK) (indicate guiding questions,
scoring criteria, and sample student responses)

[J Constructed Response: (Circle type(s): Multi-steps; Document-based questions) (indicate guiding questions, scoring
criteria, and sample student responses)

v Performance Assessment: (Circle type(s): Individual; group; product-based; performance-based; artistic;
authentic. (Indicate guiding questions, scoring criteria, and sample student responses.)

v Classroom observation (Citcle type: Formal; Informal) (¢f formal, indicate guiding questions, scoring criteria, and
sample student responses)

v Whole class discussion (indicate guiding questions, scoring criteria, and sample student responses)
Small group discussions (¢ndicate guiding question, scoring criteria, and sample student responses)
Individual student interviews (indicate interview questions, scoring criteria and student responses)

Process or Reflective measures: (Citcle type: Journals; Logs) (indicate scoring method; explain development and use of
rubrics; provide an example of a finished journal)

Portfolios (indicate scoring method; explain development and use of rubrics; provide an example of a finished portfolio)

O OO0

v’ In-class worksheet/written assignment (explain assignment and/ or provide example of student work)
0 Quiz/Test/Exam (indicate scoring method; provide an example)
v’ Others (describe)  Student lab report, including calculations, and data tables.

DESCRIPTION OF SUMMATIVE ASSESSMENT: Indicate how students’ learning of lesson objectives
(stated earlier) was comprehensively assessed. (“Post” assessment.) Include description of assignment and
sample items. *Attach scoting criteria (checklist or rubrics) used to evaluate the wotrk, and three samples
of student work (high, medium, and low).*

The pre- and post-assessments are the same. The instrument is labeled accordingly and included in the
attachments. It is graded for accuracy in terms of mathematical computations and descriptive interpretations.

AFTER LESSON IMPLEMENTATION, PROVIDE YOUR REFLECTIONS: Tell the story of what
happened in the classtroom. Indicate what worked, what you would change for the next implementation,
and students’ reactions to the lesson. Use additional pages if needed.
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*Attach to this lesson template: any and all WORKSHEETS and HANDOUTS, examples of
ALL indicated ASSESSMENTS (embedded formative and summative), and SAMPLE
STUDENT WORK.*

Living Environment Name
Period

Date

Estimating Populations Pre-Assessment
(and Post-Assessment)

1. A scientist wants an accurate estimate of the number of crickets living in a large field.
Describe one technique she could use.

2. A scientist uses a sampling technique to estimate the number of frogs living in a 1000

square meter marsh. The scientist carefully counts every frog living in one 10 square meter

section of the marsh and then multiplies this count by 100 to estimate the total population.
Describe one source of error in this technique.

Describe one way to improve the accuracy of this technique.
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3. A scientist does a mark-and-recapture study to estimate the total number of turtles living in
a large pond. The scientist randomly catches and marks 20 turtles from the pond and then releases
them. A week later, the scientist returns and randomly catches 40 turtles from the population. Four
of the turtles have a mark. Estimate how many turtles live in the pond. Show all work.

4. What does "randomly" mean as it is used in problem 3 ?

5. Describe any possible sources of error you see in using the mark-and-recapture technique.

185



MSTP Science Lesson Template

Day 1 Class Worksheet and Homework

1. A researcher uses a sampling technique to estimate the number of grasshoppers in a 1500
square meter field. She carefully counts all of the grasshoppers in a 5 square meter section of
the field. Estimate the total number of grasshoppers in the field. (Note that this is not the
mark-and-recapture method.)

2. Suppose you wish to estimate the number of Monarch butterflies in Florida in the month of
May using the mark-and-recapture method. On May 1, a random sample of 200 Monarch
butterflies is caught and tagged. On May 20, another random sample of 300 Monarch
butterflies is caught and 20 of these have tags. Set up a proportion problem and use it to
estimate how many Monarch butterflies are in Florida in the month of May.

Proportion

Solve your proportion to estimate the total population size of Monarch butterflies in Florida
in the month of May.

Show your work.

[# 3 & 4 below are similar problems requiring solution by proportion.]

3. Jenny’s Gift Shop sells candles in a variety of packages. The cost per candle is the same in
every package. A package of 8 candles costs $12.96. Write a proportion that can be used to
determine the cost of a package of 3 candles.

Proportion

Solve your proportion to determine the cost of a package of 3 candles.

Show your work.
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4. Mike made a skateboard ramp shaped like a triangle. It is 4.5 feet long and 3.0 feet high. He
wants to make another ramp that is shaped like a triangle, similar to the first ramp. The new
ramp will be 4 feet high. Write a proportion that Mark can use to find the length, x, of the
new ramp.

Proportion

What is the length, in feet, of the new ramp?

Show your work.

5. Ms. Lahti has an aquarium in her classroom. She has three types of fish: angelfish, goldfish,
and guppies. These fish are distributed in the aquarium in a ratio of 4: 6 : 10, respectively.
Determine the percent of each type of fish in the aquarium. [Hint: 4/20 is the ratio of
angelfish to the total number of fish in the aquarium. Therefore, the percentage of angelfish
in the aquarium is found by converting 4/20 to a percent.]

Set up three proportion problems and solve them to determine the three per cents requested.
Show your work.

Proportion 1:

Angelfish %

Proportion 2:

Goldfish %

Proportion 3:

Guppies %
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Investigating Populations
Lab Report Guidelines

Your lab report must include each of the following:

1.

2.

Coversheet—Activity title, your names, the date, and optional graphics.

Statement of the research question—How can the size of a population
be estimated?

Statement of the hypothesis—If a system of marking and recapturing is
used, then the size of a population of turtles in a pond can be estimated.

Introduction—A few paragraphs that give background information
about turtles and the mark-and-recapture method with repeated trials
of population sampling.

List of materials used.

Description of the procedures employed to answer the research question
and to evaluate the hypothesis.

Results—Include the data collected in a table using the format below:

Mark-and-Recapture Method with Repeated Trials
Trial number # recaptured  # recaptured having a tag (marked)
1
2
3
4
5
Totals
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Show the proportion and its complete solution for estimating the total
population size.

8. Statement of the conclusion—Restate the hypothesis and use the data as
evidence that supports the conclusion.
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Procedures for Lab Activity

Biologists often use the mark-and-recapture technique to estimate the size of a
population. In this activity, you will receive a container that represents a pond.

The container will be filled with identical items that represent the total population
of turtles in a pond. You will simulate the mark-and-recapture (with repeated trials)
technique to estimate the total number of “turtles” in the pond.

Procedure:

> You and your partner will receive a bag of goldfish, a bowl, and a magic
marker.

Empty the entire bag of goldfish into the bowl. The bowl containing the
goldfish represent the total population of “turtles” in a pond.

Capture and mark an X on 20 of the goldfish. This represents 20 marked
“turtles.”

Return the 20 marked “turtles” to the pond.

Stir the pond to distribute the “turtles” throughout the pond.

Close your eyes and recapture 15 of the “turtles.” Open your eyes and count
the number of marked turtles among the 15 that were captured. Record
these numbers in the table below. Then, return the 15 turtles to the pond.

VVV V VYV

A\

Mark-and-Recapture Method with Repeated Trials
Trial number  # recaptured # recaptured having a mark (tagged)

1 15

2 15

3 15

4 15

5 15
Totals

> Stir the pond and repeat the previous step four more times until the table is
complete. Compute the totals.

» Set up a proportion using 20 as the number marked and the totals from the
table for the number recaptured in a subsequent sample and the number
marked in a subsequent sample. Substitute these values into the proportion
below (or an equivalent proportion):
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MSTP Science Lesson Template

Number marked = Total number marked in subsequent samples
Total population Total number recaptured in subsequent samples

Solve the proportion to estimate the total population size of turtles in the
pond.

Count the number of “turtles” in the bowl to determine the accuracy of your
estimated population.

Repeat the experiment, by adding five more trials to your table.

Recalculate the totals in the expanded table.

Set up a new proportion using the new totals and calculate a new population
estimate.

Is the new population estimate more closely related to the actual population
size?

What does this tell us about the number of trials that should be taken in the
mark-and-recapture technique?
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MSTP Science Lesson Template

Grading Rubric for Lab Report

Item Points Possible Points Earned
Coversheet 6
Research

Question/Hypothesis 8
Introduction/Background

information on turtles 15
Introduction/Sampling

Methods 10
Materials 6
Procedure 10
Results/Data Table 15
Discussion 15
Conclusion 15
Total Points 100
Comments:
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Sample Technology Education Design Activity

This five-week activity introduces eighth grade technology education students to a
“hybrid” design activity which includes a computer-based design experience (using
Google Sketchup to design a bedroom), followed by a physical modeling experience
where the participants would construct the model once they optimized the design on
screen. The activity requires five weeks of classroom instructional time and its focus
would be on embedding eighth grade mathematics (scale, ratio and proportion, geometry)
into the bedroom design to assess the efficacy of contextualizing mathematics.

The bedroom design activity reflects “informed design,” a design pedagogy developed
and validated through several NSF projects conducted by the Hofstra Center for
Technological Literacy. Informed design leads students through a series of knowledge
and skill builders to inform their knowledge base prior to designing thus enabling
students to reach informed design solutions, as opposed to engaging in trial-and-error
problem solving where conceptual closure is often not attained.
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%ﬁ Mathematics, Science and

P

Technology Partnership

The National Science Foundation

Funded by

Bedroom Design — Student
Worksheets

Class and Period Date:

List students in Group:

Materials you will need: < card stock or index cards < colored paper
< foam board or cardboard < markers

State what the design challenge is:

1. Clarify the Design Specifications and Constraints
What are the specifications and constraints the design must meet?

2. Research and Investigate

In order to better complete the design challenge, you need to first gather information to
help you build a knowledge base. Completing the Knowledge and Skill Builders that follow will
enhance your ability to design a cost-effective and functional bedroom.
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Knowledge and Skill Builder 1: Geometric Shapes
It is important to understand different geometric shapes so you can use them in your design. In
this KSB you will draw different geometric shapes and determine their areas and perimeters.

A. Sketch several different rectangles that have an area of 24 square units. Complete the table
below and respond to the questions. (Show the whole numbers used for the dimensions).
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Length

Width

Area in square units

Perimeter in units

1. How do you know you have found all rectangles meeting the requirements provided?

2. What is the relationship between the dimensions of a rectangle and its area?

3. What is the relationship between the dimensions of a rectangle and its perimeter?

4. Describe the rectangle with an area of 24 square units and the greatest perimeter?

5. Describe the rectangle with an area of 24 square units and the least perimeter?
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B. Measure the dimensions of the following shapes, in inches, and determine their perimeters (in
inches) and their areas (in square inches). Round dimensions to the nearest half-inch. Formulas

[ Area=1*w, Area='2b*h,area=n 2, perimeter = 2mr ]

Perimeter
Area

Perimeter
Area

Perimeter

(circumference)
Area

Perimeter
Area

Perimeter
(circumference)
Area

Perimeter
Area




Knowledge and Skill Builder # Using Google Sketch up to create 3D drawings

1 Open Google Sketch up

a.
b.

Mo po

e

p.

Click on View>Toolbars>Uncheck getting started
Click on View>Toolbars>Check Large Tool Set (extended toolbar appears on left
side)
Discuss the power of Google Sketch up as a design tool
Click on Help>Self Paced Tutorials>Introduction
Walk through all the tabs in the Tutorial
If other self paced tutorials aren’t downloaded
i. Click on Help>Self Paced Tutorials>Get more tutorials
ii. Use the webpage to download all of the tutorials except the Introduction.
iii. Go to step g. 1.
If other self paced tutorials are downloaded
1. Open Drawing Part 1 tutorial and follow
ii. Open Drawing Part 2 tutorial and follow
ili. Open Drawing Part 3 tutorial and follow
iv. Open Breaking Edges tutorial and follow
v. Open Color and Materials tutorial and follow
Discuss the x,y,z axes and how they work in Sketch up
Discuss how 3-dimensional objects have six faces and how they can be viewed
independently in Sketch up
INlustrate the views using Camera>standard views> **%**
Change the view to Camera>standard views>Top
1. Discuss how this is the same as a Floor Plan view
Draw a few shapes but use dimensions rather than freehand drawings
1. Discuss how Sketch up keeps track of dimensions
1. Discuss the symbols used to represent feet and inches in Sketchup.
ii. As a group draw a simple shape with dimensions
i1i. Switch the standard view to see how the object looks
iv. Make the 2D drawing into 3D using the Push/Pull tool
v. Switch the standard view to see how the object looks
Begin drawing the dimensions of the minimum room size that represents the
bedroom
i. Draw the profile of the walls including standard wall thickness
ii. Raise the walls to the standard height
Draw a rectangle on any wall according to the size of window desired
Push/Pull the rectangle out to create the window opening
i. Insert a window from the Component Library according to the planned
size
ii. Make the entire room a component (select all>right-click>make
component)
Use the Component library to bring in furniture
i. Illustrate how to move, resize, and rotate objects

——

Ilustrate how to edit components to add materials
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Knowledge and Skill Builder 2. Ratio and Proportion

Scale models help in visualizing what the finished room will look like. Instead of making a full-
size drawing, we can use a scale in which 1 inch equals 1 foot. If the full-size dimension is 12
feet, the scaled dimension — the line we draw to represent 12 feet —is 12 inches long.

Whole Class Discussion

a. On separate sheets of paper, make three scale drawings of a room that measures 12 feet by 15
feet. Make one drawing for each ratio: A) Yain. =1 ft.,B) lin. =1 ft.,and C) 2 in. = 1 ft.

(Use large sheets of paper for the last 2 drawings or optionally illustrate on a board).

Which scale drawing can provide the most detail? Why?

b. What is 10% of 120 square feet? How might you use this answer to find 20% of

120 square feet?
What is 20% of 120 square feet?

Group and Individual Work
la. Assume that a room you are designing has dimensions of 12 feet by 15 feet. What is the floor

area?

1 b. Assume you are designing a trapezoidal room with an altitude of 12 feet and bases of 10
feet and 20 feet. What is the floor area?

1c. Assume you are designing a semi-circular room with a diameter of 12 feet 4 inches. What
is the floor area?

Select one of the above shapes for your room,

If the window area must be 20% of the floor area, what is the total window area?

What could be the dimensions of a square window?
Sketch a possible square window on the grid below using a scale of /4” = one foot.
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What could be the logical dimensions of a rectangular window?

Sketch a possible rectangular window on the grid below using a scale of % = one foot.

What could be the logical dimensions of a triangular window?

Sketch a possible triangular window on the grid below using a scale of %4 = one foot.

Knowledge and Skill Builder 3. Creating Nets, Folding Nets

a) Draw the following net on a piece of paper and fold it into an open box. Tape the edges.
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b) Create your own net and fold it to make a closed box, or cube.

c) Draw the following net on a piece of paper and fold it, taping the edges. What two-
dimensional geometric figures form this net?

d) Draw the following net on a piece of paper and fold it, taping the edges? What is this solid
figure called?
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Knowledge and Skill Builder 4. Aesthetics

What is the atmosphere you would like to create in your bedroom? Will it be vibrant and alive?
Quiet and cozy? The shape and design of your furnishings and the location of windows and
skylights can have a great effect. Describe the atmosphere you want. Indicate your preferences
for the shape and design of furnishings and the placement of windows.

Choose a color scheme. You can use pleasing color combinations wherever you like.

What color(s) should your room be?

What color should the floor be?

What color(s) should the furnishings be?

Knowledge and Skill Builder 5. Pricing Information

The Excel worksheet can be used for prices in designing your bedroom. However, they may not
represent the best prices available. Investigate costs in catalogs or newspaper advertisements and
change prices to make your worksheet more accurately reflect real costs.
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3. Generate Alternative Designs

Sketch two of your possible alternative solutions to the bedroom design problem. Remember to
consider the specifications and constraints. Include a description of what you consider to be each
solution’s strengths and weaknesses. Use additional sheets of paper if necessary.
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4. Choose and Justify the Optimal Solution

Choose your preferred solution. Explain how your solution meets the specifications and
constraints. What makes this alternative better?

What tradeoffs if any, did you make in selecting this alternative?
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6. Test and Evaluate

Did your design meet the initial specifications and constraints? Indicate the tests you conducted
and the experiments you performed to verify this.

Besides the initial specifications, did your particular design include any other specifications, such
as the size of the wheels or the specific materials to be used? Describe the testing procedure and
explain how the design meets all the specifications.
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7. Redesign the Solution

What problems did you encounter that would influence a redesign of your solution? Did you
change your original design concept? Why?

If you had to redesign your model, what changes would you recommend in your new design?
Explain your reasoning. What additional tradeoffs, in any, would you have to make?
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8. Communicate Your Achievements

Describe the plan you will use to present your solution to your class, and show what handouts
you will use. (You make include Power Point slides).
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© Pearson Education, Inc. All rights reserved.

Name Class Date
SELF-ASSESSMENT
, Use this scoring guide to judge your success.
Excellent | Good | Adequate | Resubmit
@ 3 @) m

Research and Investigation: | completed all the Knowledge and

Skill Builders. | fully answered all the questions asked within them.

Alternative Designs: | provided at least two sketches with good
detail and with all important elements included.

Optimal Design: | justified the optimal design solution with a
detailed explanation as to why it was the best alternative and
why it would meet the specifications and constraints.

Constructing a Prototype: | constructed a prototype based on
the optimal solution. | explained changes | made. | included a final
sketch of the prototype.

Testing and Evaluation: | tested and evaluated the final design.
The tests were conducted in a reliable and scientific fashion, and |
repeated the tests. | explained why the testing was reliable.

Data Analysis: | constructed data tables based on the testing and
used this information to explain the results from testing.

Meeting Specifications and Constraints: The design worked;
it solved the problem and met the specifications and constraints.

Redesign: | analyzed the results from testing and made sense of
them using math, science, and technological knowledge. Based
on this, | made recommendations for design improvements.

Communication: | made a well-organized, clear, written and oral
presentation to my dlass. | discussed each aspect of the design
during the presentation.

Teamwork: Our group worked well together during the entire
project. We planned tasks and helped each other, maintaining
interest and effort throughout.

TOTAL POINTS = -

208

Self-Assessment 251





